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改定履歴 

 

版数 日付 内容 備考 
0.01 2006/03/13 ・新規作成  

0.02 2006/03/16 ・６章から９章までを追記  

1.00 2006/03/17 ・誤字脱字修正  

1.10 2006/04/11 ・8bit出力手順追記 

・Device Setting,File Option ダイアログの変更 

 

1.20 2006/11/07 ・SVOボード・ディップスイッチ設定の内容を修正 

・SVOボードの選択でダイアログの表示を変更 

・PLLアップデートを追加 

 

1.21 2006/11/15 ・目次を修正 

・PLLアップデートに注意を追記 

 

1.30 2006/12/27 ・アプリケーション画面を SVOGenerator.exe の version 1.3.1.0 に変更 

 しました 

 

1.31 2007/10/31 ・SVOview.exe のマニュアルを追加しました  

1.32 2011/03/03 ・File-Option ダイアログを変更しました  

1.33 2013/02/01 ・誤字、記載ミスを修正しました  

1.34 2013/10/15 ・File-Option ダイアログを変更しました 

・Device-Setting ダイアログを変更しました 

・システム構成から Windows2000 を削除しました 

・必要なソフトウェアに 64bit版デバイスドライバーを追記しました 

・インストール CDの内容表記を変更しました 

 

2.00 2015/03/20 ・SVO-03専用に改訂しました  

2.10 2015/04/28 ・Device-Setting 画面を変更しました 

・Device-Control 画面を変更しました 

 

2.20 2015/05/29 ・誤字脱字を修正しました 

・Device-Setting 画面を変更しました 

・Device-Control 画面を変更しました 

※SVO-03の FPGAバージョンが 080以上で対応 

 

2.30 2015/07/14 ・Device-Control 画面に Trigger Out チェックを追加しました 

・File-Openでサポートする動画ファイルで AVIファイルをサポートしま 

 した 

 

2.40 2015/08/14 ・ボード写真を変更しました 

・Windows8.1 64bit をサポートを追加しました 

 

2.50 2016/01/29 ・Device-Setting 画面における、DDR出力対応、ビデオタイミングの設定を

見直しました 

 

2.60 2016/03/09 ・Device-Setting 画面の設定値を変更、標準出力波形に合わせました。  

2.70 2016/03/15 ・Device Control 画面に Information として FPS、BPS を表示するようにし

ました 

・Device-Setting 画面にて設定方法を Easy/Standard/Advance から選べるよ

うにしました 

・14.Device Setting 詳細を Easy/Standard/Advance でそれぞれ記載しまし

た 

 

2.80 2016/03/29 ・Device Control 画面の Advance タブに 8bit 出力時の出力モードを追加し

ました 

 

2.90 2016/07/06 ・8.4.ファイルオプション（解析情報）設定にピクチャタイプ RGB24を追加

しました 

・11.制限事項にサポートする AVIファイルについて追加しました。 

・Device-Setting-Easy タブの 1 Clock Bit Size,1 Pixel Bit Size に 24

を追加しました 

・Device-Setting-Standardタブの 1 Clock Bit Size に 24を追加しました 

・Device-Setting-Advanceタブの 1 Clock Bit Size に 24を追加しました 

・13.4. Video Clock Setting (Easyタブ)の 1ClockBitSize、１PixelBitSize
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について 24を追記しました 

・13.6.Pixel Settting（Standardタブ）の 1ClockBitSize、１PixelBitSize

について 24を追記しました 

・13.7.Pixel Settting（Advanceタブ）の 1ClockBitSize、１PixelBitSize

について 24を追記しました 

3.00 2016/07/21 ・Device Setting 画面の各タブで設定する VCLK 設定の単位を MHz とし、記

載ページの Device Setting の図を変更しました 

 

3.10 2017/01/18 ・8.4.ファイルオプション（解析情報）設定を修正しました 

・8.9.SVOボードの操作を修正しました 

・14.Device Control 詳細を修正しました 

 

3.20 2017/04/14 ・7. SVOボード・ディップスイッチ設定を修正しました 

・8.1 アプリケーション操作の流れを修正しました 

・13. Device Setting 詳細を修正しました 

 

3.30 2017/11/07 ・8.13.SVO-03 ボードのマルチアップデート方法を追加しました 

・13.25. Input Video Timing Setting （Hdmiタブ）を修正しました 
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1. システム概要 

 

SVO とは画像データなどのデジタルデータを出力するイメージ・ジェネレーター・システムで

Windows上のソフトウェアとハードウェア及びファームウェアから構成されます。 

本システムをお使いになることで、画像データの受信処理、画像処理などがカメラなどのデバ

イスがない状態で評価することが可能になります。 

下図にシステム構成および SVOハードウェア画像を示します。 

 

システム構成図 

 

SVO ハードウェア画像 

 

 

ホスト PC 

Windows7 32bit/64bit  

 

 

 

画像表示／ 

出力用アプリ 

 SVOGenerator  
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ドライバ 

USB3.0 
SVO board 

<SVO-03> 

ハードウェア 

ファームウェア  

 

 

 

画像 

出力 

ライブラリ  

ターゲット 

ボード  

フラットケーブル等 
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2. 動作環境 

 

○ ハードウェア 

PC   ： Windows7/8.1が問題なく動作する環境 

CPU           Core i5 GHz以上 

または同等の CPU 

メモリー        4GB以上 

ハードディスク空き容量 10ギガバイト以上 

USB仕様        3.0 必須  ※AsMedia製チップでは保証できません 

モニタ ： フルカラー表示可能なもの 

他   ： USB3,0ケーブルなど 

※Windows10は現在評価中です、評価終了次第ホームページでお知らせします。 

 

○ ソフトウェア 

OS   ： Windows7/8.1 64bit/32bit 

他   ： 弊社提供アプリケーション、ライブラリー、 

      デバイスドライバー(8.1は 64bitのみ) 
 

3. 必要なソフトウェア 

 

SVOシステムを動作させるために必要な弊社提供のソフトウェアは以下の通りです。 

 

・SVOGenerator.exe 

  弊社専用の画像データファイルを読み込み表示を行い、この画像データをターゲット・ボ 

ードへ指定タイミングで出力することができるアプリケーションです。 

 

・SVOUSB30.dll 

  SVOシステム専用の USB3.0デバイスドライバーを使用した SVO画像出力ライブラリーです。 

  上記アプリケーションを使用せず、お客様システムに本ライブラリーを組み込むことも可 

能です。 

 

・SVOUSB30.sys、SVOUSB30.inf 

  32bit版 SVOシステム専用 USB3.0デバイスドライバーファイルです。 

 

・SvoU3drv.dll、SvoUdrv.inf、．．． 

  64bit版 SVOシステム専用 USB3.0デバイスドライバーファイルです。 

 

※SVOGenerator終了後、以下のファイルが生成されます。 

・SVOGenerator.ini 

  主に File-Option ダイアログの情報を保存します。 

・SVOGenerator.svo 

  主に Device-Settingダイアログの情報を保存します。 
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4. SVOハードウェア概要 

 

SVOハードウェア（SVO-03）には①Xilinx製 FPGA（Spartan6-LX16）、②Cypress EZ-USB/FX3、

③SDRAM（128MB）が実装され、イメージ・ジェネレーターを実現しています。 

 
 

ホスト PC とは④USB3.0 ポートにて接続します。また SVO の出力先となるターゲットボードと

は⑤50ピンヘッダーで接続します。 

① Xilinx 製 FPGA（Spartan6-LX16）は SDRAM 制御、イメージ・ジェネレーター処理、バス管

理を行います。 

② Cypress 製 USB3.0 コントローラ（EZ-USB/FX3）はホスト PC との USB インターフェースを

行います。 

③ SDRAM（128MB）は出力する画像データなどを格納します。 

① 

② 

③ 

④ 

⑤ 
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5. インストール 

 

SVO ハードウェアに同梱されています、ソフトウェア CD－ROM に必要なソフトウェアが格納さ

れています。この CD-ROMの内容は下表の通りです。 

 

フォルダ 内容 

\ readme.txt、version.txtを格納しています 

\SVO-AP_x86 アプリケーション、ライブラリー関連を格納しています 

\SVO-AP_x64 上記 64bit版を格納しています 

\Driver_x86 SVO 専用 USB3.0デバイスドライバー関連を格納しています 

\Driver_x64 上記 64bit版を格納しています 

\DOC 各種ドキュメントを格納しています 

\画像出力ﾗｲﾌﾞﾗﾘ 画像出力ライブラリーファイルを格納しています 

\Tool フレームファイルコンバーターユーティリティーを格納しています 

 

5.1. SVO 専用 USB3.0 デバイスドライバーのインストール 

 

①SVOボードと PCの USB3.0インターフェースポートを USB3.0ケーブルで接続します。 
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②”ドライバーソフトウェアのインストール”ダイアログが開きます。（64bit版） 

 
 

しばらくすると、インストールされませんでしたのメッセージが表示されます。 

 
 

③デバイスマネージャーを起動し、下図のように”他のデバイス”に SVO-03 が登録されてい

ますので、SVO-03をダブルクリックします。 
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④”SVO-03のプロパティ”ダイアログが表示されますので、”ドライバーの更新”ボタンをク

リックします。 

 
 

⑤”ドライバーソフトウェアの更新 - SVO-03”ダイアログが表示されますので、”コンピュ

ータを参照してドライバーソフトウェアを検索します”をクリックします。 
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⑥CD-ROM を CD ドライブに挿入し、参照ボタンにてドライバーフォルダを選択し、次へボタン

をクリックします。 

 
 

⑦ドライバーのインストールが始まりますが、すぐに”Windows セキュリティ”のダイアログ

が表示されます。このドライバーソフトウェアをインストールしますをクリックします。 
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⑧インストールが開始します。 

 
 

⑨しばらくすると、下図のようにインストールが終了します。 

 
 



                       SVOシステムソフトウェアマニュアル Rev.3.30 

NDC00012 

 

Net Vision Corp. 

 

13 

 

⑩再びデバイスマネージャーを見ると、SVOクラスに SVO-03が登録されました。 

 
 

※Windows7 32bitへのドライバーインストールは CD-ROMの Driver_x86に格納のデバイスドラ

イバーをご使用ください。 

※過去に SVI ボード用のデバイスドライバーをインストールした場合は、”SVI”の下に”

SVO-03”が表示される場合がありますが、動作上問題ありません。 

 

5.2. アプリケーション、ライブラリー関連のインストール 

 

CD-ROM内の SVO-AP_x64フォルダをハードディスクの任意の場所へコピーしてください。 

念のためコピー先の SVO-AP_x64 フォルダの属性が読み書き可能になっているのを確認して下

さい。 

 

※Windows7 32bit版は CD-ROMの SVO-AP_x86フォルダに格納されています。使用方法は同一で

す。 
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6. アンインストール 

 

SVO 専用 USB3.0 デバイスドライバーのアンインスト－ルとアプリケーションの削除の手順に

ついて説明します。 

SVO のアンインストールは通常は 6.2「アプリケーション、ライブラリー関連のアンインスト

ール」のみを行ってください。PC上から完全に SVOをアンインストールしたい場合のみ 6.1「SVO

専用 USB3.0デバイスドライバーのアンインストール」を行ってください。 

 

6.1. SVO 専用 USB3.0 デバイスドライバーのアンインストール 

 

SVO専用デバイスドライバーのアンインストールは、デバイスマネージャーにて、SVO-03を削

除してください。下図のように”このデバイスのドライバーソフトウェアを削除する”にチェ

ックをしてください。 

 

 

6.2. アプリケーション、ライブラリー関連のアンインストール 

コピーした SVO-AP_x64 フォルダを削除してください。SVO-AP_x64 フォルダ内のアプリケーシ

ョンレジストリへの書込みを行いません。そのためフォルダの削除により、アプリケーション、

ライブラリ関連のアンインストールが完了します。 
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7. SVOボード・ディップスイッチ設定 

SVOシステムのソフトウェアは、1台の PCに複数の SVOボードが接続されることを想定してい

ます。当初のソフトウェアでは、複数の SVOボードから 1つだけ選択し使用することができま

す。将来的には同時に複数の SVOボードを使用できるようするつもりでいます。 

そこで、複数の SVO ボードが接続された時に、それぞれの SVO ボードを識別するために、SVO

ボード上のディップスイッチ“S2“にて番号を付けることができます。番号は 00から 07まで

で、下表の設定になっています。（S2-6番から 4番までを使用） 

 

番号 S2-8 S2-7 S2-6 S2-5 S2-4 S2-3 S2-2 S2-1 Device-Select表示 About Dialog 表示 

0 OFF OFF OFF OFF OFF OFF OFF OFF 0000 0000xxxx 

1 OFF OFF OFF OFF ON OFF OFF OFF 0001 0001xxxx 

2 OFF OFF OFF ON OFF OFF OFF OFF 0002 0002xxxx 

3 OFF OFF OFF ON ON OFF OFF OFF 0003 0003xxxx 

4 OFF OFF ON OFF OFF OFF OFF OFF 0004 0004xxxx 

5 OFF OFF ON OFF ON OFF OFF OFF 0005 0005xxxx 

6 OFF OFF ON ON OFF OFF OFF OFF 0006 0006xxxx 

7 OFF OFF ON ON ON OFF OFF OFF 0007 0007xxxx 

 

“xxxx”には Windows が認識し割り振った番号が 0 から Fの範囲で付与されます。 

 

HDMI版で起動する場合、以下の設定で自動起動させることが可能です。 

S2-7 が OFF の状態で SVOGenerator を起動し、Hdmi タブの設定を行い Write ROM で設定を

SPI-ROMに書き込みます。 

S2-7 を ON にする事で、SPI-ROM から設定を読み込んで起動するモードに切り替わるため、再

度 PCから設定を行う事なくデータを出力する事が可能です。 

設定の詳細は 13章に記載してあります。 
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8. アプリケーション操作方法 

SVOGeneratorを使った、基本的なアプリケーションの操作の一連の流れと個別の操作方法を説

明します。またアプリケーションの項目の詳細についてはアプリケーションのヘルプも参照し

てください。 

 

8.1. アプリケーション操作の流れ 

SVO デバイスからデータを出力するまでの基本的な流れを示します。この手順を実行すること

により SVOデバイスからデータを出力することができます。またそれぞれの各項目については

次節以降を参照してください。 

 

USB版                        HDMI版 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

アプリケーション（SVOGenerator）の起動 

ファイルオプション（解析情報）設定 

データファイルの読込み 

データ確認 

SVOボード選択 

SVOボード設定情報作成 

SVOボードへのデータ送信 

SVOボードの操作 

アプリケーション（SVOGenerator）の終了 

 

アプリケーション（SVOGenerator）の起動 

SVOボード選択 

SVOボード設定情報作成 

SVOボードへのデータ送信 

アプリケーション（SVOGenerator）の終了 
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8.2. アプリケーション（SVOGenerator）の起動 

 

①5.2“アプリケーション、ライブリー関連のインストール”でコピーした SVO-AP_x??フォ

ルダ内にある“SVOGenerato.exe”を実行します。 

②下図の SVOGeneratorの画面が表示されます。表示された SVOGeneratorのステータスバー

に“Ready”と表示されていることを確認します。 

 
以上で起動終了です。 

 

8.3. アプリケーション（SVOGenerator）の終了 

 

①“File”→“Exit”をクリックするか、画面右上の“×”ボタンをクリックします。 

 
以上でアプリケーションは終了です。 
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8.4. ファイルオプション（解析情報）設定 

 

①“File”→“Option”をクリックするか、ツールバーの アイコンをクリックします。 

②“File Option”ダイアログが表示される

ので、これから読み込むデータファイルにあ

った設定を行います。 

 

 

 

 

・PictureType：画像データのカラーフォー

マットを指定します。 

・1 Color bit width：1カラーを生成するビ

ット幅を 8,10,12,16 から選択します。YUV

系、RGB565、RGB24は 8bitを選択、RAWはデ

ータに応じて設定します。 

・ViewPlaySpeedは整数で FPS値を指定しま

す。30fps であれば 30、15fps であれば 15

を指定します。 

③設定が終了したら“OK”ボタンをクリックします。 

 

※ファイルオプションの設定はデータファイルを読み込んだ後でも変更可能です。その場合 

 “OK”ボタンをクリック後 File Optionの設定を元に画像データの再解析を実行します。 
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8.5. データファイルの読込み 

 

①“File”→“Open”をクリックするか、ツールバーの アイコンをクリックします。 

②“ファイルを開く”ダイアログが表示されるので、適切なファイルを選択します。 

 
※SVI で作成したファイル以外のファイルを開いた場合、アプリケーションの動作が不安定

になることがあります。その場合は再度アプリケーションを終了し起動しなおしてくださ

い。拡張子”.frmt”、”.frm”、”.avi”のファイルを開けます。 

※AVI ファイルの場合、サポートするカラースペースは"YUY2","UYVY","DIB "となります。

また無圧縮のみのサポートです。 

③File Optionの設定を基に、データの解析を行います。終了すると画像を表示します。 

 
※解析が正常に終了するとステータスバーに“Analyze Complete”と表示されます。 

解析が途中で異常終了した場合ステータスバーに“Analyze Incomplete”と表示されます 

※YUV系で色が不正な場合は File-Optionにて並びを変更してみてください。 
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8.6. データ確認 

 

①“View”→“Play”または、ツールバーの アイコンを選択しデータを１フレームずつ確

認します。 

 

 
②ステータスバーには現在表示中のフレーム番号、画像サイズが出ていますので、再生中に

適宜参照してください。 

②画像データのフレームを飛ばしながら確認したい場合には“View”→“Jump To” 

画像データの色を確認したい場合には“View”→“Color Bar” 

ファイルのヘッダ情報を参照したい場合には“View”→“File Information” 

で確認してください。 

ステータスバーや各ダイアログの詳細は SVOGeneratorの Helpを参照してください。 
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8.7. SVO ボードの選択 

 

①“Device”→“Select”クリックするか、キーボードの“F3”、またはツールバーの を

押します。 

  
②“Device Select”ダイアログが表示されます。ドロップダウンリストに現在 USB ポート

に接続されている SVO ボードの識別 IDが表示されますので、制御を行うボードの IDを選

択します 

 
※表示される IDは USBポートに接続している SVOボードにより異なります。 

③IDの選択を行ったら、“Select”ボタンを押します。 

 
以上でデバイス選択は終了です 
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8.8. SVO ボードの設定情報作成 

①“Device”→“Setting クリックするか、キーボードの“F4”または、ツールバーの ア

イコンをクリックします。 

  

②“Device Setting”ダイアログが表示されます。各設定項目を設定します。 

 
※上図の各設定については、“13.Device Setting詳細”をご参照下さい。 

※”SAVE SET”ﾎﾞﾀﾝは現在の DeviceSetting内容を任意のﾌｧｲﾙへ保存することができます。 

※”RESTORE SET”ﾎﾞﾀﾝは任意の DeviceSetting ﾌｧｲﾙを読み込むことができます。 
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④ 設定が終了したら“Apply”ボタンを押します。 

 

以上で設定は終了です。 
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8.9. SVO ボードの操作 

①“Device”→“Control”またはツールバーの アイコンをクリックします。 

 （キーボードの“F6”を押しても選択できます） 

  
Device-Control ダイアログが表示されますと、最初に SDRAM に入る分のフレームを転送し

ます。 

②“Device Control”ダイアログが開き、Play ボタンが有効になったら、転送可能状態に

なります。 

 
③問題なければ、“PLAY”ボタンを押します 
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④転送が始まると、Play ボタンが無効状態になり、Current Positionが TotalOutputFrames

までカウントアップされます。転送中に“STOP”ボタンを押すことで、強制終了すること

ができます。ファイル全てを転送し終わると、再び“Play”ボタンが有効状態になります。 

 

 

8.10. Deivce Control - Play Setting 

・Play cycle ： 1 サイクルのみ出力にするか、無限サイクルで出力するか設定します。 

OFF時 1サイクルのみ出力、ON時無限サイクルで出力 

・Play mode ： ボード内のメモリー分のみ無限に出力するか、逐次 PCから画像を転送して

出力するか設定します。 

OFF時ボード内のメモリー出力、ON時 PCから逐次出力 

・Image sync ： 出力と同時に PC側画面の画像を 1秒毎に更新します。 

OFF時更新しません、ON時更新します。 

・External Trigger ： 画像出力スタートトリガー入力を有効とします。 

・External V/HSync ： 画像出力時、外部入力の V/HSync 信号を使用して出力を行います。 

・External PCLK ： 画像出力時、外部入力の PCLK信号を使用して出力を行います。 

・Trigger Out ： 複数 ch同時出力時にマスターとなる SVOボードから画像出力トリガー信

号を出力することができます。 

・Information fps / bps ： 設定よりフレームレート、ビットレットを計算し表示します。 

 

8.11. SVO-03 ボードのファームウェア・アップデート方法 

SVO-03 ボードのファームウェアのアップデートを行います。 

 

手順１．SVO-03 ボードを PC に接続し、SVO-03 ボードの電源を投入してください。 

手順２．SVOｇenerator.exe を起動してください。 

手順３．Device メニューの Select をクリックして、アップデートを行う、SVO-03 ボードを選択してください。 

  

手順４．Tool メニューの Firmware Update をクリックしてください。 
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手順５．ファイル選択ダイアログが表示されますので、so○fwxxx.bin を選択し開くボタンをクリックしてください。 

手順６．マウスカーソルが砂時計に変わります。しばらくすると砂時計が矢印しに戻り、下図の完了メッセージが表示さ

れます。 

 

手順７．OK ボタンをクリックし、SVOｇenerator を終了してください。 

手順８．SVO-03 ボードを PC から外して電源を切ります。 

 

注意：ファームウェア・アップデートと FPGAアップデートは連続して実行することはできません。 
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8.12. SVO-03 ボードのＦＰＧＡアップデート方法 

SVO-03 ボードの FPGAのアップデートを行います。 

 

手順１．SVO-03 ボードを PC に接続し、SVO-03 ボードの電源を投入してください。 

手順２．SVOｇenerator.exe を起動してください。 

手順３．Device メニューの Select をクリックして、アップデートを行う、SVO-03 ボードを選択してください。 

  

手順４．Tool メニューの FPGA Update をクリックしてください。 

 

手順５．ファイル選択ダイアログが表示されますので、so○fpgaxxx.bin を選択し開くボタンをクリックしてください。 

手順６．マウスカーソルが砂時計に変わります。しばらくすると砂時計が矢印しに戻り、下図の完了メッセージが表示さ

れます。 

 

手順７．OK ボタンをクリックし、SVOｇenerator.exe を終了してください。 

手順８．SVO-03 ボードの電源を切ります。 

注意：FPGAアップデートとファームウェア・アップデートは連続して実行することはできません。 
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8.13. SVO-03 ボードのマルチアップデート方法 

SVO-03HDMI ボードでは、マルチアップデートにてボードのアップデートを行います。 

 

手順１．SVO-03 ボードを PC に接続し、SVO-03 ボードの電源を投入してください。DSW7 番は OFF にします。 

手順２．SVOｇenerator.exe を起動してください。 

手順３．Device メニューの Select をクリックして、アップデートを行う、SVO-03 ボードを選択してください。 

 

手順４．Tool メニューの Multi Update をクリックしてください。 

 

手順５．ファイル選択ダイアログが表示されますので、so3mxxx.bin を選択し開くボタンをクリックしてください。 

手順６．マウスカーソルが砂時計に変わります。しばらくすると砂時計が矢印しに戻り、下図の完了メッセージが表示さ

れます。 

 

手順７．OK ボタンをクリックし、SVOｇenerator.exe を終了してください。 

手順８．SVO-03 ボードの電源を切ります。 
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9. SVOボード LED ランプ状況 
SVO-03ハードウェア仕様書をご覧ください。 

 

10. アプリケーション・エラーメッセージ一覧 

画像出力中、その他処理中にエラーが発生することがあります。アプリケーションはエラーが

発生した場合はメッセージボックスを表示し、ユーザへエラー発生を通知します。エラー発生

後、各処理に従い処理を終了します。以下の表にエラーメッセージ、エラー発生の要因、対処

法を記載します。 

 

10.1. アプリケーションエラー 

項目番号 １ 

エラーメッセージ Device UnOpened 

エラー内容 SVO ボードの Open処理に失敗 

エラー発生の要因 ・SVOボードの電源が切れた 

・SVOボードの異常 

・アプリケーションからボードが認識できない 

対処法 1.一度、アプリケーションを終了し、SVOボードの電源を OFFにする 

2.ボードの電源を入れ、アプリケーション再立ち上げ 

 

項目番号 ２ 

エラーメッセージ Play Failure（ダイアログの２行目に SVOAPIエラーも表示） 

エラー内容 SVO デバイスからのデータ送出処理に失敗 

エラー発生の要因 ・SVOボードが処理実行中 

・アプリケーションからボードが認識できない 

対処法 ・SVOボードの処理が終了するまで待つ 

上記で対処できない場合は項目番号１の対処法を実行 

 

項目番号 ３ 

エラーメッセージ Shared Memroy UnOpen 

エラー内容 SVO メモリーデータ、画像表示用のメモリー領域が確保できない 

エラー発生の要因 仮想メモリー領域の不足 

対処法 仮想メモリー領域を増やす 

 

項目番号 ４ 

エラーメッセージ File Open Failure 

エラー内容 ファイル Openに失敗 

エラー発生の要因 ・指定されたファイルがーオープンできない。 

・既に別のアプリケーションでオープンされている 

・指定したパスにファイルが見つからない 

対処法 ・ファイルを使用していれば、使用を終了する 

・正しいファイルパスを設定する 
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項目番号 ５ 

エラーメッセージ Update Incomplete 

エラー内容 FPGAもしくは Firmwareのアップデートに失敗 

エラー発生の要因 ・SVOデバイスが Openできない 

・SVOボードが処理中 

・ファイルデータが不正 

対処法 ・SVOボードの処理を終了させる 

・ファイルを確認する 

 

項目番号 ６ 

エラーメッセージ Not Data Analyze 

エラー内容 データ解析が終了していない 

エラー発生の要因 ・データを取得していない 

・ファイルのデータが解析できない 

対処法 ・データを取得する 

・ファイルを確認する 

 

項目番号 ７ 

エラーメッセージ Not Selected Device 

エラー内容 SVO ボード未選択 

エラー発生の要因 SVO ボードの選択を行っていない 

対処法 SVO ボードの選択を行う 

 

項目番号 ８ 

エラーメッセージ Not Idol 

エラー内容 SVO ボードが処理実行中 

エラー発生の要因 SVO ボードが処理を実行している 

対処法 SVO ボードの処理が終了するまで待つ。 

項目番号１の対処法を実行する 
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10.2. SVOAPIエラー 

項目番号 ９ 

エラーメッセージ Win32API Error（２行目にエラーの詳細情報） 

エラー内容 Windows の APIエラー 

エラー発生の要因 詳細情報による 

対処法 詳細情報による 

 

項目番号 １０ 

エラーメッセージ Connect No Device or Power Off 

エラー内容 USB に SVOボードがつながれていない。または電源が入っていない 

エラー発生の要因 ・SVOボードが USBに接続されていない 

・SVOボードの電源がはいっていない 

対処法 ・デバイスマネージャで SVOUSB20が認識されていることを確認 

・SVOボードを接続する 

・SVOボードの電源を入れる 

 

項目番号 １１ 

エラーメッセージ Device Multi Open 

エラー内容 複数の SVOボードを Openしようとしている 

エラー発生の要因 ・複数の SVOボードを Openしようとしている 

・１つの SVOボードに対して２重に Openしようとしている 

対処法 ・２重 Openしていないか確認する 

・複数の SVO ボードを１つのアプリケーションで Openしようとしていな

いか確認する 

 

項目番号 １２ 

エラーメッセージ Device UnOpened 

エラー内容 SVO ボードが Openしていない 

エラー発生の要因 Openしていない SVOボードに対して処理をしようとしている 

対処法 ・SVOボードを Openする 

・Controlダイアログを閉じて、メニューの Controlを選択する。 

 

項目番号 １３ 

エラーメッセージ Parameter Incorrect 

エラー内容 設定パラメータの異常 

エラー発生の要因 設定パラメータが間違っている 

対処法 設定パラメータの確認 

 

項目番号 １４ 

エラーメッセージ FW Update TimeOut 

エラー内容 Firmwareアップデートに失敗 

エラー発生の要因 ・SVOボードが処理中 

・ファイルデータが不正 

対処法 ・SVOボードの処理を終了させる 

・ファイルを確認する 
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項目番号 １５ 

エラーメッセージ FPGA Update TimeOut 

エラー内容 FPGAアップデートに失敗 

エラー発生の要因 ・SVOボードが処理中 

・ファイルデータが不正 

対処法 ・SVOボードの処理を終了させる 

・ファイルを確認する 

 

項目番号 １６ 

エラーメッセージ Image Data Not Stored In SVO 

エラー内容 SVO ボードのメモリーにデータが格納されていない 

エラー発生の要因 SVO ボードのメモリーにデータが格納されていない 

対処法 SVO ボードへデータを転送する 

 

項目番号 １７ 

エラーメッセージ Command Busy 

エラー内容 SVO ボードが処理中 

エラー発生の要因 SVO ボードが処理実行中 

対処法 SVO ボードが処理が終了するまで待つ 

 

項目番号 １８ 

エラーメッセージ Command Incorrect 

エラー内容 規定されていないコマンドを SVOボードに送った 

エラー発生の要因 規定されていないコマンドを SVOボードに送った 

対処法 送信コマンドの確認 

 

項目番号 １９ 

エラーメッセージ Paramater Incorrect 

エラー内容 コマンドパラメータ不正 

エラー発生の要因 ・コマンドパラメータ値があっていない 

・パラメータの数が違う 

対処法 ・コマンドパラメータの確認 

 

項目番号 ２０ 

エラーメッセージ Command Not Supported 

エラー内容 規定されていないコマンドを SVOボードに送った 

エラー発生の要因 規定されていないコマンドを SVOボードに送った 

対処法 送信コマンドの確認 

 

項目番号 ２１ 

エラーメッセージ Not Idol 

エラー内容 SVO ボードが処理実行中 

エラー発生の要因 SVO ボードが処理を実行している 

対処法 SVO ボードの処理が終了するまで待つ。 

項目番号１の対処法を実行する 
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11. 制限事項 

 

項目番号 制限事項 回避策 

１ “Device Control”ダイアログの“Sync”チェ

ックをチェックした場合、SVOGenerator画面が

SVO ボードデータ出力中の画像表示を行うが、

画面表示が SVO 出力データに対して遅延して表

示される。 

・高性能な PCにする。 

（処理上の遅延であるため根本

的な回避策はない） 

２ “Device Control”ダイアログの“Sync”チェ

ックをチェックし、“PLAY”中に“File Option”

ダイアログまたは“Device Setting”ダイアロ

グを表示するとメインウィンドウの背面に表示

されてしまう 

“File Option”または“Device 

Setting”ダイアログを表示した

場合は、キーボードの“Alt”キ

ーを押すと前面に表示される 

３ “Device Select”など SVOボード関連の操作を

行ったときに“Win32API Error”が発生すると、

それ以降 SVO ボードへのアクセスが異常になる 

SVOGeneratorを終了し、SVOボー

ドの電源を OFF にする。その後

SVO ボードの電源を ON にし、

SVOGeneratorを起動する 

４ “Device Setting”で解析対象画像の情報と異

なった設定を行うと、SVO ボードが異常動作を

することがある。 

異常動作を起こした設定を行わ

ないようにする 

５ “Device Control”ダイアログで“PLAY”動作

中に SVOボードが異常動作をすると、STOP ボタ

ンなどが動作しなくなる 

SVOGeneratorを終了し、SVOボー

ドの電源を OFF にする。その後

SVO ボードの電源を ON にし、

SVOGeneratorを起動する 

６ ”File-Open”で AVIファイルを指定した場合、”

Not Support”のエラーメッセージが表示され

る。 

※AVIファイルの場合、サポート

す る カ ラ ー ス ペ ー ス は

"YUY2","UYVY","DIB "となりま

す。また無圧縮のみのサポートで

す。 
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12. FRM形式の画像データフォーマットについて 

 

SVO システムで対応する画像データは SVI システムで作成された FRM 形式と一般的な AVI形式

があります。 

FRM形式はカメラモジュールまたはイメージセンサから出力されたデータをフレームごとに 40

バイトのヘッダーが付加されたもので、フレームの前にヘッダーが記録されます。 

データ部はカメラから出力されたままを記録します。但しフレーム部のバイト数は 64 で割り

切れるようパディングデータが付加されています。 

以下に、FRM形式の画像ファイルフォーマットの詳細を示します。 
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画像の階調が 10ビット、12ビット、16ビットのバイト並びはビックエンディアンとなります。 

FRM ファイルは最大 2GB の制限がありますので、それ以上になる場合は複数の FRM ファイルと

し、管理するために FRMT ファイルを使用します。FRMT ファイルはテキスト形式で FRM ファイ

ル名を絶対パス付で記録したものです。 

 例）Cドライブ直下の Dataというフォルダに FRM ファイルが 2つある場合 

  C:\Data\data0001.frm 

  C:\Data\data0002.frm 

FRMTファイルはテキスト形式ですので、Notepadなどのテキストエディターなどで編集ができ

ます。上記ように FRMファイルが 2つしかなくても以下のように同じ FRMファイルを複数行に

することで長時間の出力が可能となります。出力は FRMT ファイルの記述通りの順番で出力さ

れます。 

 例）Cドライブ直下の Dataというフォルダに FRM ファイルが 2つあって、同じファイルを 

   3回コピーして長時間出力に対応する場合 

  C:\Data\data0001.frm 

  C:\Data\data0002.frm 

  C:\Data\data0001.frm 

  C:\Data\data0002.frm 

  C:\Data\data0001.frm 

  C:\Data\data0002.frm 

  C:\Data\data0001.frm 

  C:\Data\data0002.frm 
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13. Device Setting詳細 

 

“Device”-“Setting”メニューで表示される“Device Setting”ダイアログについて解説を

します。本ダイアイアログでは、タブページ切り替えによる 4種類の設定方法を選択して設定

することができます。 

下図（Easy）の赤枠で囲んだタブですが、4種類の設定ができるようになっています。 

 Easy  ：画像サイズとブランク領域 1種類(x-Blank)で設定を行います。 

 Standard ：画像サイズとブランク領域 3種類(SYNC,FP,BP)で設定を行います。 

 Advance  ：PCLK 単位の細かい設定を行います。 

  Hdmi  ：SVO-03HDMI版として動作させるための設定を行います。 

[SAVE SET],[RESTORE SET],[Apply]ボタンは現在のタプページに対応します。 

 
 

次ページ以降に上記設定を Easyタブ、Standadタブ、Advanceタブ、Hdmiタブで行った際のダ

イアログと出力イメージを示します。 
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Easyタブでの設定と出力イメージ：FullHD,YUV,16bit出力 
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Standardタブでの設定と出力イメージ：FullHD,YUV,16bit出力 
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Advanceタブでの設定と出力イメージ：FullHD,YUV,16bit出力 
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Hdmiタブでの設定と出力イメージ：1280x380,YUV,8bit出力 
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13.1. Sync Porality Setting (Easy タブ、Standard タブ、Advance タブ) 

 

VSYNC：VSYNCの SYNC 期間の極性を指定できます。LowActive と HighActive が選択できます。 

HSYNC：HSYNCの SYNC 期間の極性を指定できます。LowActive と HighActive が選択できます。 

 

13.2. Sync Setting (Hdmi タブ) 

 

VSYNC Polarity：VSYNC の SYNC 期間の極性を指定できます。LowActive と HighActive が選択

できます。 

HSYNC Polarity：HSYNC の SYNC 期間の極性を指定できます。LowActive と HighActive が選択

できます。 

HSYNC Pulse：Vブランク中に HSYNCパルスを発生させるか ON,OFFで設定できます。 

 

13.3. V-Blank Setting (Easy タブ) 

 
HSync Pulse：Vブランク中に HSYNCパルスを発生させるか ON,OFFで設定できます。 

Blanking Code：Vブランク、Hブランク期間のデータを設定できます。 

 

13.4. V-Blank Setting (Standard タブ、Advance タブ) 

 
Blanking Code：Vブランク、Hブランク期間のデータを設定できます。 

 

13.5. Blank Setting (Hdmi タブ) 

 
Blanking Code：Vブランク、Hブランク期間のデータを設定できます。 
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13.6. Video Clock Setting (Easy タブ) 

 
DCK Mode：SVO-03が出力する DCK（Video Clock）の設定を行います。 

 
DCK Modeでは、上図のように 6種類の選択が可能となっています。 

詳細は DCK出力のハードウェア仕様書の「１１．SDR/DDRモード設定」をご参照ください。 

Video Clock (SDR rate)：SDR Rateでのビデオクロック周波数を設定します。 

 
お使いになりたい周波数が存在しない場合には、弊社までお問い合わせください。 

 

1 Clock Bit Size：1クロックあたりの画像データバス幅を設定します。8,16,24,32の設定が

可能です。8と設定した場合は、1回のピクセルクロックでデータ出力バスのうち、D0-D7の 8

ビットが有効であることを意味します。16と設定した場合は、1回のピクセルクロックでデー

タ出力バスのうち、D0-D15の 16ビットが有効であることを意味します。 

32 と設定した場合は、1 回のピクセルクロックでデータ出力バスのうち、D0-D31 の 32 ビット

が有効であることを意味します。YUVの場合は 1クロックで 2画素出力されます。32ビットで

出力する際は CN5も使用しますので、CN5の 10pin ヘッダーも実装する必要があります。 

24 と設定した場合は、1 回のピクセルクロックでデータ出力バスのうち、D0-D23 の 24 ビット

が有効であることを意味します。RGB24 専用となり出力する際は CN5 も使用しますので、CN5

の 10pinヘッダーも実装する必要があります。 

AVIファイル（DIB-無圧縮）の場合は、24を設定します。 

 

1 Pixel Bit Size：画像フォーマットに合わせて、1 画素を構成するビット数を設定します。

8,10,12,16,24が設定可能です。 
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8と設定した場合は、1ピクセルが 8ビットであることを意味します。（RAW8） 

10と設定した場合は、1ピクセルが 10ビットであることを意味します。（RAW10） 

12と設定した場合は、1カラー成分が 12ビットであることを意味します。（RAW12） 

16と設定した場合は、1カラー成分が 16ビットであることを意味します。（YUV、RGB565） 

24と設定した場合は、1カラー成分が 24ビットであることを意味します。（RGB24） 

AVIファイル（DIB-無圧縮）の場合は、24を設定します。 

 

13.7. Video Clock Setting (Standard タブ、Advance タブ、Hdmi タブ) 

 
DCK Mode：SVO-03が出力する DCK（Video Clock）の設定を行います。 

 
DCK Modeでは、上図のように 6種類の選択が可能となっています。 

詳細は DCK出力のハードウェア仕様書の「１１．SDR/DDRモード設定」をご参照ください。 

Video Clock (SDR rate)：SDR Rateでのビデオクロック周波数を設定します。 

 
お使いになりたい周波数が存在しない場合には、弊社までお問い合わせください。 

 

13.8. Pixel Setting (Standard タブ) 

 
1 Clock Bit Size：1クロックあたりの画像データバス幅を設定します。8,16,24,32の設定が

可能です。8と設定した場合は、1回のピクセルクロックでデータ出力バスのうち、D0-D7の 8

ビットが有効であることを意味します。16と設定した場合は、1回のピクセルクロックでデー

タ出力バスのうち、D0-D15の 16ビットが有効であることを意味します。 

32 と設定した場合は、1 回のピクセルクロックでデータ出力バスのうち、D0-D31 の 32 ビット

が有効であることを意味します。YUVの場合は 1クロックで 2画素出力されます。32ビットで
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出力する際は CN5も使用しますので、CN5の 10pin ヘッダーも実装する必要があります。 

24 と設定した場合は、1 回のピクセルクロックでデータ出力バスのうち、D0-D23 の 24 ビット

が有効であることを意味します。RGB24 専用となり出力する際は CN5 も使用しますので、CN5

の 10pinヘッダーも実装する必要があります。 

AVIファイル（DIB-無圧縮）の場合は、24を設定します。 

 

1 Pixel Bit Size：画像フォーマットに合わせて、1 画素を構成するビット数を設定します。

8,10,12,16が設定可能です。 

8と設定した場合は、1ピクセルが 8ビットであることを意味します。（RAW8） 

10と設定した場合は、1ピクセルが 10ビットであることを意味します。（RAW10） 

12と設定した場合は、1カラー成分が 12ビットであることを意味します。（RAW12） 

16と設定した場合は、1カラー成分が 16ビットであることを意味します。（YUV、RGB565） 

24と設定した場合は、1カラー成分が 24ビットであることを意味します。（RGB24） 

AVIファイル（DIB-無圧縮）の場合は、24を設定します。 

 

13.9. Pixel Setting (Advance タブ) 

 
1 Clock Bit Size：1 クロックあたりの画像データバス幅を設定します。8,16,32 の設定が可

能です。8 と設定した場合は、1 回のピクセルクロックでデータ出力バスのうち、D0-D7 の 8

ビットが有効であることを意味します。16と設定した場合は、1回のピクセルクロックでデー

タ出力バスのうち、D0-D15の 16ビットが有効であることを意味します。 

32 と設定した場合は、1 回のピクセルクロックでデータ出力バスのうち、D0-D31 の 32 ビット

が有効であることを意味します。YUVの場合は 1クロックで 2画素出力されます。32ビットで

出力する際は CN5も使用しますので、CN5の 10pin ヘッダーも実装する必要があります。 

24 と設定した場合は、1 回のピクセルクロックでデータ出力バスのうち、D0-D23 の 24 ビット

が有効であることを意味します。RGB24 専用となり出力する際は CN5 も使用しますので、CN5

の 10pinヘッダーも実装する必要があります。 

AVIファイル（DIB-無圧縮）の場合は、24を設定します。 

 

1 Pixel Bit Size：画像フォーマットに合わせて、1 画素を構成するビット数を設定します。

8,10,12,16が設定可能です。 

8と設定した場合は、1ピクセルが 8ビットであることを意味します。（RAW8） 

10と設定した場合は、1ピクセルが 10ビットであることを意味します。（RAW10） 

12と設定した場合は、1カラー成分が 12ビットであることを意味します。（RAW12） 

16と設定した場合は、1カラー成分が 16ビットであることを意味します。（YUV、RGB565） 

24と設定した場合は、1カラー成分が 24ビットであることを意味します。（RGB24） 

AVIファイル（DIB-無圧縮）の場合は、24を設定します。 

 

8bit Output Mode：8bit 出力時に CN4 コネクタの CD0-CD7 に出力するか、CD8-CD15 に出力す

るかを設定します。D0-D7で CD0-CD7に出力、D8-D15 で CD8-CD15に出力します。 
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13.10. Pixel Setting (Hdmi タブ) 

 
1 Clock Bit Size：1 クロックあたりの画像データバス幅を設定します。8,16,32 の設定が可

能です。8 と設定した場合は、1 回のピクセルクロックでデータ出力バスのうち、D0-D7 の 8

ビットが有効であることを意味します。16と設定した場合は、1回のピクセルクロックでデー

タ出力バスのうち、D0-D15の 16ビットが有効であることを意味します。 

32 と設定した場合は、1 回のピクセルクロックでデータ出力バスのうち、D0-D31 の 32 ビット

が有効であることを意味します。YUVの場合は 1クロックで 2画素出力されます。32ビットで

出力する際は CN5も使用しますので、CN5の 10pin ヘッダーも実装する必要があります。 

24 と設定した場合は、1 回のピクセルクロックでデータ出力バスのうち、D0-D23 の 24 ビット

が有効であることを意味します。RGB24 専用となり出力する際は CN5 も使用しますので、CN5

の 10pinヘッダーも実装する必要があります。 

AVIファイル（DIB-無圧縮）の場合は、24を設定します。 

 

1 Pixel Bit Size：画像フォーマットに合わせて、1 画素を構成するビット数を設定します。

8,10,12,16が設定可能です。 

8と設定した場合は、1ピクセルが 8ビットであることを意味します。（RAW8） 

10と設定した場合は、1ピクセルが 10ビットであることを意味します。（RAW10） 

12と設定した場合は、1カラー成分が 12ビットであることを意味します。（RAW12） 

16と設定した場合は、1カラー成分が 16ビットであることを意味します。（YUV、RGB565） 

24と設定した場合は、1カラー成分が 24ビットであることを意味します。（RGB24） 

AVIファイル（DIB-無圧縮）の場合は、24を設定します。 

 

Byte Swap：データ信号のバイトアラインメントのスワップの方法を指定します。 

 Mode0：D3D2D1D0を D3D2D1D0と出力します（YYV時は Y0,U,Y1,V出力） 

 Mode1：D3D2D1D0を D2D3D0D1と出力します（YYV時は U,Y0,V,Y1出力） 

 Mode2：D3D2D1D0を D3D0D1D2と出力します（YYV時は Y0,V,Y1,U出力） 

 Mode3：D3D2D1D0を D0D3D2D1と出力します（YYV時は V,Y0,U,Y1出力） 

 

13.11. Sync Code Setting (Easy タブ) 

 
Enable Sync Code：SAV/EAV コードを付加するかどうかを設定します。チェック ONの時、付加

します。チェック ON時に付加される SAV/EAVコードの 4バイト目は下図の通りです。 
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13.12. Sync Code Setting (Standard タブ、Advance タブ) 

 
Sync Code Settingは Active Videoの両端に SAV/EAVコードを付加することを設定できます。 

Enable Sync Code (SAV/EAV)チェックを ON にすると SAV/EAV コードを付加して出力すること

ができます。この場合でも VSYNC/HSYNCの同期コードは出力されます。 

EAV-[1-4] 4th, SAV-[1-4] 4thのエディットボックスには独自の同期コードを指定することが

できます。デフォルトでは下記の規定のコードが出力されます。  

 

13.13. Output information (Easy タブ) 

 
Frame Widthは 1フレームの水平方向ビデオクロック数を表示します。 

Frame heightは 1フレーム全体のライン数を表示します。 

FPSは出力フレームレートを表示します。 

 

13.14. Output information (Standard タブ、Advance タブ、Hdmi タブ) 

 
Frame Widthは 1フレームの水平方向ビデオクロック数を表示します。 

Frame heightは 1フレーム全体のビデオクロック数を表示します。 

FPSは出力フレームレートを表示します。 

 

13.15. Blanking Setting (Easy タブ） 

 

H-Blank：水平方向のブランクをピクセル数で設定します。 

V-Blank：垂直方向のブランクをライン数で設定します。 
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13.16. Video Timing Setting （Standard タブ） 

 

VFP：垂直方向のフロントポーチをライン数で設定します。 

VSYNC：垂直方向の同期期間をライン数で設定します。 

VBP：垂直方向のバックポーチをライン数で設定します。 

 

HFP：水平方向のフロントポーチを PCLK数で設定します。 

HSYNC：水平方向の同期期間を PCLK数で設定します。 

HBP：水平方向のバックポーチを PCLK数で設定します。 
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13.17. Video Timing Setting （Advance タブ） 

 
出力するビデオタイミングを設定します。下図のタイミングチャートを参考に PCLK 数または

Repeat 数を 10 進で設定してください。HSPR は下図の HSP1-HSP?-HSPR になり、一般的にライ

ン数を設定します。DEPR も同様となります。DEPP、DEPR は Active Video Setting の Width、

Heightと同じであり、こちらを設定すると自動的に Active Video Settingの更新を行います。 

 
 

13.18. Video Timing Setting （Hdmi タブ） 

 

VFP：垂直方向のフロントポーチをライン数とピクセル数で設定します。 

VSYNC：垂直方向の同期期間をライン数で設定します。 

VBP：垂直方向のバックポーチをライン数とピクセル数で設定します。 
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HFP：水平方向のフロントポーチを PCLK数で設定します。 

HSYNC：水平方向の同期期間を PCLK数で設定します。 

HBP：水平方向のバックポーチを PCLK数で設定します。 

 
 

13.19. Active Video Setting （Easy、Standard タブ、Hdmi タブ） 

 
画像サイズを幅（Width、ピクセル数）、高さ（Height、ライン数）で設定します。 

 

13.20. Active Video Setting （Advance タブ） 

 
画像データの幅（Width、PCLK数）と高さ（Height、ライン数）を表示します。上記 Video Timing 

Setting の DEPP、DEPR と同じになり、DEPP、DEPR に入力された値は自動的にこちらに反映さ

れます。 

 

13.21. Output Image / Test （Hdmi タブ） 

 

Output Image：設定した値による波形イメージを表示します。現在は使用できません。 

Test：DIP スイッチ 7 を OFF にしている状態で設定した値をボードに反映させます。SPI-ROM

には書き込まれないので、ボードの電源を切ると設定はボードに保持されません。 
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13.22. Read ROM / Write ROM （Hdmi タブ） 

 

Read ROM：ボード上の SPI-ROM より、以前書き込まれた設定を読み Hdmi タブ内に表示させま

す。 Device Selectによりボードを指定する事で使用可能になります。 

Write ROM：ボード上の SPI-ROM に Hdmi タブ内の設定を書き込みます。Device Select により

ボードを指定する事で使用可能になります。ボードの電源を切っても設定は保持されるため、

DIP スイッチ 7 を ONにした状態でボードを起動すると再度 PCから設定をする事なくデータの

出力が可能です。 

 

13.23. Display Name （Hdmi タブ） 

 

Display Name：SVO-03HDMI にて作成した仮想ディスプレイの名前を 13 文字以内で指定する事

ができます。 

 

13.24. Read Set / Write Set （Hdmi タブ） 

 

Read Set：.svoファイルより設定値を読み込みます 

Write Set：.svo ファイルに設定値を書き込む事ができます。最大 5 セット書き込む事が可能

です。 
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13.25. Input Video Timing Setting （Hdmi タブ） 

 
HDMI入力先に対する映像設定を行います。 

H blank：水平方向のブランク数をピクセル数で設定します。（偶数） 

V blank：垂直方向のブランク数をライン数で設定します 

W：水平方向の画素数を設定します。（偶数） 

H：垂直方向の画素数を設定します。 

Clip_X：クリップする場合の水平方向の開始座標を設定します。（偶数） 

Clip_Y：クリップする場合の垂直方向の開始座標を設定します。 

Pixel Freq：モニター用ピクセル周波数を以下より選択します 

27MHz、54MHz、72MHz、74.25MHz、108MHz 

V Freq：Active Video Settingグループ内の Width、Heightと上記設定からリフレッシュレー

トを算出して表示します。この算出された値が HDMI 信号出力機器とサポートしていない場合

は正常に映像を受信できません。 

 

HDMIからの入力画像に対して、クリップする場合は Clip_X、Clip_Yにて開始座標、Active Video 

Settingの Width、Height でクリップ幅、クリップ高さを設定します。 

クリップをしない場合は Clip_X、Clip_Yは 0を設定してください。当然 Active Video Setting

の Width、Heightは Input Video Timing Settingの Wと Hと同じになります。 

 

 

 

 

 

 

 

 

 

 



                       SVOシステムソフトウェアマニュアル Rev.3.30 

NDC00012 

 

Net Vision Corp. 

 

52 

 

14. Device Control詳細 

 

“Device”-“Control”メニューで表示される“Device Control”ダイアログの設定と動作に

ついて解説します。 

 

 
 

14.1. Play Setting 

Device-Seting で設定された画像出力タイミングで、どのように各画像フレームを出力するか

設定を行います。また、外部同期出力、複数の SVO ボードを使用して同期出力の設定も行いま

す。 

 

・Play cycleは読み込んだ画像ファイルを無限で出力するか 1回のみの出力にするかを設定し

ます。チェック OFFで 1回のみ、チェック ONで無限となります。 

 

・Play modeは画像データを逐次 PCから送信するか、SVOボード内のメモリーに格納された画

像データだけにするかを設定します。チェック OFF で SVOボード内のメモリーに格納された画

像データ、チェック ON で画像データを逐次 PC から送信になります。チェック OFF の時、SVO

ボードのメモリーに収まりきらない画像ファイルの場合は画像ファイル先頭からメモリーに

入る分だけを格納します。 

 

・Image syncは画像出力中に画像表示画面を更新するかを設定します。チェック OFFで更新を

行いません、チェック ONで 1秒おきに更新を行います。ただし Play modeがチェック ONの時

に有効です。 

 

・External Triggerは SVOボードの汎用入力ポート（P4）に接続された外部トリガー信号を入

力し、画像出力開始をするかを設定します。チェック OFFで外部トリガーなしで出力し、チェ

ック ONで外部トリガーによる画像出力を行います。 

 

・External V/HSync は SVO ボードの汎用入力ポート（P4,P5）に接続された外部 VSync 信号、
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外部 HSync信号を入力し、入力した Sync信号のタイミングで画像出力を行うかを設定します。

チェック OFF で外部 V/Hsync 入力なしで出力し、チェック ON で外部 V/HSync タイミングで画

像出力を行います。このチェックが ON の場合無条件に「External PCLK」もチェック ON とな

り選択できないようになります。VSync、HSyncそれぞれの入力を受け付けるのは以下のピンで

す。 

○外部 VSync信号入力ピン；コネクタ 4の 11番ピン 

○外部 HSync信号入力ピン；コネクタ 4の 50番ピン 

○外部 PCLK信号入力ピン；コネクタ 4の 9番ピン 

 

・External PCLK は SVO ボードの汎用入力ポート（P3）に接続された外部 PCLK 信号を入力し、

入力した PCLK 信号のタイミングで画像出力を行うかを設定します。チェック OFF で外部 PCLK

入力なしで出力し、チェック ONで外部 PCLKタイミングで画像出力を行います。 

 

・Trigger out は SVO ボードの汎用出力ポート（P0）に接続された外部トリガー信号を出力す

るかを設定します。チェック OFF で外部トリガー出力なしで、チェック ON で外部トリガー出

力ありになります。外部トリガー出力は複数の SVO ボードから同期出力を想定した運用で使用

され、マスターとなる SVOボードから外部トリガー信号を出力し、マスター自信も含め外部ト

リガー入力を行い、入力した外部トリガー信号を画像出力開始トリガーとし、画像出力を開始

します。 

CN4：3番：P0
CN4：11番：P4

CN4：11番：P4

CN4：11番：P4

CN4：11番：P4

Ch.1
マスター

Ch.2

Ch.3

Ch.4

SVOボード

 

CN4:3番:P0は外部トリガー出力信号で、CN4:11番:P4は外部トリガー入力信号です。 

上図の 4 台の SVO ボードで同期出力を行う場合は、Ch.2～Ch.4 の SVO ボードを制御する

SVOgenerator.exeで外部トリガー待ち（Extrenal trigger ON）で画像出力を開始（Play）し、

次に ch.1のマスターで自分自身も外部トリガー待ち（Extrenal trigger ON）で画像出力を開

始（Play）し、100msecウェイト後、外部トリガー出力を行います。Ch.1～Ch.4 の SVOボード

は外部トリガー入力を受信して、画像出力となります。 
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・Information fps / bps：出力フレームレート、出力ビットレートを表示します。 


